
Thank you very much for choosing Kairon.
=======================================================

An asterix * on the menu denotes that the 
selection is deactivated in the Demo Version of Kairon.
To upgrade to the full version, you will need to 
personalize Kairon by entering your name and this 
line of code when the program starts:

Ka-24404-28056-40721-i

If you have any questions after reading this short 
introduction, I can be reached at my website URL:

http://Kilian.Stern.net
or e-mail address is:
Kilian@Stern.net

please send all snail-mail to:
     Kilian Sternad, Traungasse 1/3/12, A-1030 Vienna
or  Kilian Sternad, Brielgasse 32, A-6900 Bregenz
     A  U  S  T  R  I  A

( PLEASE NOTE THE BLUE TEXT  AT THE BOTTOM OF THIS PAGE, TOO!  )

GENERAL
=======================================================

To display a graphic chart on the screen, 
select "View Zodiac" or "View Grid" from the "View" Menu.
Data may be entered by selecting "New..." from the "File" menu, 
or "Open..." to access an old file.

You may TAB through the input fields.  
The "Close Box" of each window has the same function as 
"Close" in the "File" menu, that is, the original file is not altered.

Kairon is so tiny that it may be placed one one micro floppy disk.  
The standard ephemeris is from 1586-2131AD, and can be loaded 
without any further installation.

MENU REFERENCE
=======================================================

1) File:



1.1) "New..." displays the empty "personal data" dialog, and 
erases any previous data from the heap, except the colour 
settings. This enables you to use your favorite colour settings 
in different files, but reset other settings. 
"OK" closes the dialog, and puts your data on the heap, but 
does not save anything to a document yet. Here your chart is 
automatically calculated, no matter if you just leave the 
dialog through "OK" ("enter", ...) or if you explicitly click 
the "calculate" button. --> Exception: "cancel"!

1.2) "Open..." enables Kairon to read its own documents 
(i.e. documents created by Kairon). No other documents are 
displayed. The original Kairon package is equipped with a 
folder called "documents" in the Kairon folder. This 
"documents" folder contains four chart examples, that 
you can explore. 
Kairon allows only one open document at a time.
To compare charts, Kairon provides you with special 
functions called synastry*, composite* (calculates house 
cusps according to any location specified) and combine* 
("time-space-midpoint-chart") in the "View" menu. 
All new aspects are displayed instantly.
Documents may be opened by "double-clicking" them or 
by simply dragging the document onto the Kairon icon.

1.3.1) Import as AAF (A&B-Chunk)... :
Will allow you to read properly set up "AAF"-documents.
The "A-" and the "B-Chunk" are supported, Kairon will use the 
settings of the open Kairon-file. To gain speed turn off 
"Confirm Conversion" in the Control Panel "MacOS Easy Open".

1.3.2) Import as Astrolog 5.30++... :
Allows you to read "Astrolog 5.30"-documents and newer ones.
To gain speed turn off "Confirm Conversion" in the Control Panel "MacOS Easy 
Open".

1.4) "Close" closes the corresponding dialog 
or window without saving any data changes.

1.5) "Save"* saves any changes made to data.  
This cannot be undone, so be sure to back up 
your most important documents from time to time.

1.6) "Save as..."* saves your documents under any name 
you select, in any folder you wish. Always check your 
destination folder carefully, so you can find your data again!



Creating sub-folders may be a great help in organizing your files. 
Documents created by Kairon use no more than 4K, or 3317 bytes.

1.7) "Save as Pict..."* saves your chart as a "pict file" that
can be printed via SimpleText, but you should scale down 
the percentage of the paper size to approximately 18%.
Tip: Using Photoshop, don't "open" picts, but "import" them 
to make best use of the advantages of the "pict2"-format.
"Picts" may be used by other software, as long as you install 
the "Kilistars" font,  so that the glyphs will be displayed 
properly. A special Tip to cut your Graphics and to change
their size will be the use of QuarXPress or other high-quality
DTP-Software which will support printing hairlines.

1.8.1) Export as AAF (A&B-Chunk)... :
Kairon supports the Astrological Exchange Format 
(Astrologisches-Austausch-Format) and allows you to export
AAF-Data in plain Text to share them with other Applications.

1.8.2) Export as Astrolog 5.30++... :
Export original Astrolog 5.30 Data and later and share with
DOS and Unix and Windows- Users. (Plain Text)
Half daylight saving times will be named as daylight saving
time, the half remaining hour will be taken from the zone.
In case of double dailight saving time the second hour will
be added to the zone, the setting will be "DT" anyways.
So in those two special cases you will get identical Calculation Data with non - 
identical zone data.
Local Data will be transferred via the corresponding zone, too.

1.9) "Page Setup..." allows you to select any paper size.  
Kairon will adjust to your selection automatically. 
Rotating your page will print horizontally on the selected page.

1.10) "Preview" shows you on the screen what colours "Print..." 
will use. If ColourQuickDraw is not available on your machine, 
"Preview" will be disabled. 

1.11) "Print..." Kairon™ is capable of printing  in colour.  
If you select the "Print B&W" checkbox in the "Colours..." dialog 
of the "Preferences" menu, Kairon™ enables you to get a clear 
black and white print without any loss of colour definition. 
After printing, deselect the B&W checkbox 
and the screen colour reappears.

1.12) "Quit" closes all windows and dialogs. 
There is a reminder to save unsaved data.



2) Zodiac

2.1) "Hide MenuBar" The Menu Bar will only disappear 
AFTER you select "View Zodiac" or "View Grid" from 
the "View" menu. Once you have selected "Hide MenuBar" 
the text changes to "Show MenuBar", to indicate 
its present condition.  

Although you can no longer see the Menu Bar, it functions  
by means of the "short commands" indicated near the menu's 
actual commands. The short commands are selected by 
holding down the command (apple) button while clicking 
the corresponding key. 
Your most important command is "apple-w", to close your 
corresponding window and show your Menu Bar again.

2.2) "Copy Chart" will copy your graphics to the clipboard, 
enabling you to paste the chart into a file.  Please note that 
if the "Kilistars" font is not installed, the symbols used 
will not be displayed properly.

2.3-2.6) "100%, 110%, 120%, 95%" will effect the screen 
graphics accordingly if "View Zodiac" has been selected.  
This command is available through short commands even 
when the Menu Bar is hidden.

2.7-2.9) "View Top, View Center, View Bottom" is only 
available if "View Zodiac" has been selected previously. 
The short commands shift or reset your graphics even 
if you are in "Hide MenuBar" function. 

2.10-2.11) "date++, date--" (date plus, date minus) is 
only available in combination with an open Zodiac or 
Grid Window.  There must be an actual "Direction"* 
or "Transit" and the option "Show Synastry" selected.

In case of a transit, each call decrements or increments 
the date by one day, in case of a direction by one year.  
This command is available through short commands 
even when the Menu Bar is hidden.

2.12) "Mirror..."* displays the "reflected axis" dialog.  
It reflects all planets, points, etc. along the selected 
axis and displays them around your chart.



3) Preferences

3.1) "Name, Data..." displays the "personal data" dialog. 
"OK" closes the dialog, puts your data on the heap 
but does    n  o  t    recalculate your document. 
THE CALCULATE BUTTON MUST BE SELECTED 
TO CALCULATE A CHART. If you don't enter any data and 
click "OK" Kairon will calculate a "here and now" chart 
for you on basis of the system-configuration of your mac.
This can be changed from the control panels "world map" 
and "date and time".

3.2) "Objects-Selection..." selects those objects you 
wish to view in "View Zodiac" and also all objects 
you wish to see in "View Grid". 

If "Show Synastry" is selected, you can also define the 
planets that are to be drawn around your chart. If you 
are looking at a Grid, a rectangular grid will be shown. 
In this case you can separately define the planets that 
are to be drawn on the right side (inner) and at the 
bottom of the grid (outer).

3.3) "Objects-Orbs..." allows you to set the width of orbs 
for each aspect defined in "Aspects-Orbs..." for every object 
individually. You may increase/decrease each orb by five 
percent each time you press + or -.

3.4) "Aspects-Orbs..." allows you to specify the orb for each 
aspect individually. Select or deselect the corresponding 
check-boxes to tell Kairon which of the 19 possible aspects 
you wish to be drawn and calculated on your chart. 
You may also select the colours for each aspect.

3.5) "Elements-Values..." defines how Kairon will count 
the points that describe the power of each element in 
your chart. Please note that the use of the Sidereal 
zodiac will lead to different results than the use 
of the Tropical or Astronomical zodiac.

3.6) "Input..." Here you can get a close view of every 
position and also change it if you wish. Note that 
recalculating your chart will not actualize any 
self-defined positions.

3.7) "Time-Machine..." enables you to cast Return Charts 



for all objects including Asc and MC.

3.8) "Colours..." You may select the maximum colour that your 
screen will allow. Choose from three predefined models.
Save Colour-Settings: Kairon creates no specific
"Preferences-File" in your System Folder. Nevertheless 
you can use any chart you have ever created as the preference
for any number of new charts, either by duplicating it via the
finder or by using the "Save as..." command from the file menu.
Therafter all that has to be done is to chose "Name, Data..."
from the preferences menu instead of "New..." from the 
file menu to change your entries.

4) View

4.1) "View Zodiac" If "Hide MenuBar" has been selected 
previously, all of your screen will be used to display your 
chart. See 2.1-2.10, and 4.13-4.15.

Description of the Main Glyphs used by Kairon:

Õ - Aries
Œ - Taurus
œ - Gemini
– - Cancer
— - Leo
“ - Virgo
” - Libra
‘ - Scorpio
’ - Saggitarius
÷ - Capricorn
◊ - Aquarius
ÿ - Pisces

≠ - Sun
Æ - Moon
 Ø - Mercury
 ∞ - Venus
 ± - Mars
 ≤ - Jupiter
 ≥ - Saturn
 ¥ - Uranus

 µ - Neptune
 ∂ - Pluto
 ∑ - Chiron
∏ - Lilith
π - north Node (true)



∆ - south Node (true)
 

 æ - Ceres
    ø - Pallas

 ¿ - Juno
   Ω - Vesta

 ¬ - Point of Fortune
 º - Vertex 
 ≈ - sens. Point of Astrology (viz. H.E. Douval)

   ƒ - sens. Punkt of Occultism (viz. H.E. Douval)

    ¡ - Isis (Transpluto) <not calculated>
   √ - East Point <not calculated>

4.2) "View Grid" If "Hide MenuBar" has been selected 
previously, all of your screen will be used to display your 
chart. Symbols used are: Â-fire, Ì-earth, Ô-air, Ï-water. 
"k"= cardinal, "f"= fixed, "m"= mutable. Please note that the 
use of the Sidereal zodiac will lead to different results 
than the use of the Tropical or Astronomical zodiac.

Description of the Aspect-Glyphs used by Kairon:

 Ÿ - Conjunct .........................0°
 ⁄ - Semisextile .................30°
 € - Decile ...........................36°
 ‹ - Novile ...........................40°
 › - Semisquare ................45°
 fi - Septile ...................360/7°
 fl - Sextile .........................60°
 ‡ - Quintile ........................72°
 · - Binovile .......................80°
 ‚ - Square ...........................90°

„ - Biseptile .............720/7°
 ‰ - Tredezile ..................108°
 Â - Trine ...........................120°
 Ê - Sesquisquare ...........135°
 Á - Biquintile..................144°
 Ë - Quincunx.................... 150°
 È - Treseptile .........1080/7°
 Í - Tetranovile ..............160°
 Î - Opposition .................180°

4.3) "Show Synastry" shows and hides the planets that are 
drawn "outside" the zodiac as well as the dialogue menu "both" 



in the dialog "Objects-Selection..." of the "Preferences" menu. 
In the "both" menu of the "Aspects-Orbs..." dialogue of the 
"Preferences" menu tells Kairon, whether it should display 
only the aspects between the inner objects;  between the 
inner and the outer objects; or both together. 

4.4) "Synastry New..."* selects the document that you wish 
to be drawn inside by use of the "radix1" switch, and the 
document to be drawn outside by use of the "radix2" switch. 

"OK" places your selection on the heap and asks you to save 
your data. If you wish to discard your changes, press "cancel" 
instead of "OK".

 4.5) "Composite New..."* selects the documents that you wish 
to use for the calculation of your composite chart by means of 
the "radix1" and the "radix2" switches. Specify an exact location 
to make your calculations more accurate. This will change the 
inclination of the house cusps axis, that are recalculated on the 
basis of the  "midpoint-MC" and the defined location. Location 
cannot be changed thereafter, this would spoil the chart.

"OK" places your selection on the heap and asks you to save 
your data. If you wish to discard your changes, press "cancel" 
instead of "OK".

4.6) "Combine New..."* selects the documents that you wish 
to be considered for the calculation of your combined chart 
by means of the "radix1" and the "radix2" switches.

"OK" places your selection on the heap and asks you to save 
your data. If you wish to discard your changes, press "cancel" 
instead of "OK".

4.7) "Transits..." The "now" button gives the present date 
and time as the basis of the calculation of the objects, that 
are to be displayed on the chart. Do not forget to check the 
Time zone and for Daylight Saving Time. 

Transits can be displayed in a graphic chart on the screen if 
you select "View-Zodiac" or "View-Grid" from the "View"menu. 
A tighter orb of 1 degree is traditionally used for transits, except 
for the most powerful transits to the Lights and perhaps Pluto.

Selecting "date++"* and "date--"* from the "Zodiac"menu lets 
you change the date of your Transit chart by one day at a time 
without explicitly having to use the transits dialog.



4.8) "Directions..."*  calculate progressive and regressive 
directions for Asc & MC, and select either the true solar arc 
or an average calculation following the rule of Naibod. 

Selecting "date++"* und "date--"* from the "Zodiac"-menu lets 
you change the date of your direction chart by one year at a time 
without explicitly having to use the directions dialogue.

4.9) "Solar, Lunar..."* calculate return charts for your natal 
sun or moon,  or find out the last new moon preceding your birth. 
Each time you activate the "septar" radio button, the date of your 
chart will increase by seven years, activating the "decar" radio 
button will increase it by ten years.

4.10) "Personars..."* here you calculate the transgression 
charts of the sun during the first year of the native's life.

4.11) "Tropical Zodiac" the most commonly used zodiac, based 
on convention.  It puts  0° Aries at the beginning of spring.

4.12) "Astronomical Zodiac" uses the Tropical zodiac, surrounded 
by the actual astronomical signs. "Ó" is called the snake bearer.

4.13) "Sidereal Zodiac" uses the zodiac with 12 signs of equal 
size, that have moved according to the exact precession of 
time. Note that you will not get the same elements using 
the sidereal zodiac and the tropical zodiac!

4.14) "Calendar..." Select your corresponding time zone. 
The checkbox "Lunar" is responsible for drawing a lunar 
chart of the open chart for the given month. Please be a 
little bit patient, for Kairon has to calculate the position 
of sun and moon for every day of the given month as well 
as the state of the moon. This may take a few seconds 
more than simply casting a chart.

5) Houses

Select one of 6* house systems. 

"Null Houses" takes 0° of Aries for the beginning of 
30° equal house-cusps. This is quite useful, if you do not 
know any exact birth time. Please note that also here the 
use of the sidereal zodiac will lead to different results.



6) Aspects

All 19 aspects can be selected and deselected 
individually or in groups...

ABOUT Kairon
=======================================================
Kairon™ intends to be simple and powerful both at the 
same time. It wants to come close to a handdrawn chart. 
Therefore the user may select and deselect as many planets 
and aspects as there are, independently between the inner 
and the outer planets in synastry like charts. 

You may freely interpret your planets any way you consider 
reasonable and should define their value accordingly.

The ephemeris is valid from 1586-2131 AD and may 
be extended from 5000 BC until 3000 AD. This download 
can be done through the corresponding link on my homepage 
and is free.

===============================================================
The 2.xx Series of Kairon ends with this issue.
Kairon 2.xx will continue to be freeware, but will not be 
extended any further. Nevertheless the claim to be an open
concept will not come to an end, but will be continued with 
the new series called 3.xx, an open concept that unites the 
mathematical capabilites of the Macintosh with your intuition. 

The enormous input I have received will be put into action 
in every detail and within due time a new release of Kairon
will be found at my WWW-Adress:  http://Kilian.Stern.net
All news will continue to be spread via my mailing-list and 
anybody is welcome to ask to be registered there. Any note
to be erased from that list will be respected immediately.

Registriering und being kept on current via snail mail is
possible too, but this way I have to ask for a setup fee
of U$ 5.- put into the same envelope like the request. 
Snail mail correspondence will only be answered, as long
as you add an envelope with your address on it and put the
stamps-money into it, too, which will be one buck.
This is a life-long service, time does not matter; as many
envelopes I will have received as many news I will send.
As there is no fee on Kairon I have to go for sure that there 



won't be any fees for me, either....;-))
===============================================================

Credits given to Dr. Alois Treindl who has written the 
8000 Year Ephemeris Placalc that grants the accuracy of 
the house cusps and the sidereal data generated by Kairon 
as well its extreme speed.

One thousand and twenty four thanks to Roxxi (Brenda Balachsan) 
for going through all this and brushing up my English. 
(Unfortunately her service was no longer available 
for this version)

The Concept of the Program is based on the Macintosh Human 
Interface Guidelines and my personal convictions for granting 
ease of use, aestheticism, versatility and simplicity.

A really big "Thank you" to Martin Garms, who has been a great
help in implementing the AAF-routines for Kairon and who did
the testing. Many of his suggestions will have to wait for a 
future version of Kairon to come, but I will work them out.

All the graphics and the integrated font are my own creation. 
The idea of sharing Kairon this way was inspired by the 
generous example of Walter D. Pullen, who has written 
his famous "Astrolog".

Thanks also to Jamie McCornack and to Ingemar Ragnemalm, 
whose publication has made the tiny UFO fly and who have been 
an enormous help to me writing the GWorlds for Kairon™. 

And last but NOT least thanks to Mr Peter Fraiss, one of the 
great pioneers of astro-software, who, by means of his program 
"Sarastro" has clearly disclosed the enormous astrological 
capabilities of the PC.

If there should be any bugs in this program, they are wholly 
based on my own shortcoming  and I will do my very best to 
eradicate them all.

For your time with Kairon™ I wish you all the diplomacy, 
Intuition, humility and love available. Yours sincerely...,

Kilian.

PS ... and never to forget: "ZH", the Zodiak Hacker, 
who was my first and most important link on the web.




